Dear Dr. Johnson,

The proof of your manuscript is attached on the following pages. Please read through the document carefully to check for accuracy, reference citations, and figures and tables. Please also be aware a professional copyeditor may have edited your manuscript to comply with the JGO style requirements.

In addition to proofing the article, the following queries have arisen during the preparation of your paper. Please address the queries listed below by making the appropriate changes in the text.

If you have any other revisions that you would like to make, this will be the last opportunity to do so before the article is published. In particular, please ensure that the author’s names and affiliations have been identified correctly, and the address of the corresponding author is correct.

If the changes cannot be easily described through email, please annotate this proof according to the annotation guidelines as detailed on the following page.

<table>
<thead>
<tr>
<th>Query Reference</th>
<th>Query</th>
<th>Author's response</th>
</tr>
</thead>
<tbody>
<tr>
<td>Q1</td>
<td>Please note that alterations cannot be made after you have approved for publication, irrespective of whether it is Online First.</td>
<td></td>
</tr>
<tr>
<td>Q2</td>
<td>Author SURNAME (family name) has been highlighted in red-please check that these are correct.</td>
<td></td>
</tr>
<tr>
<td>Q3</td>
<td>Please check affiliation, correspondence detail.</td>
<td></td>
</tr>
<tr>
<td>Q4</td>
<td>Please check acknowledgements section and confirm the Footnote.</td>
<td></td>
</tr>
<tr>
<td>Q5</td>
<td>Please note that the link with the DOI number for the manuscript should be valid only after the whole issue is official published.</td>
<td></td>
</tr>
<tr>
<td>Q6</td>
<td>Highlighted in Table 1: Please confirm whether these revisions are OK.</td>
<td></td>
</tr>
</tbody>
</table>

Once you have completed your revisions and/or addressed all the queries, or if you are satisfied with the proof in its existing form, please email: e-proof@amepc.org.

To ensure the timely publication of your article, please respond within 48 hours.
Making corrections


Adobe Professional 7:
Tools → Commenting → show Commenting Toolbar

Adobe Reader 8:
Tools → Comments & Markup → show Comments and Markup Toolbar

Adobe Reader 10 and above:
Comment → choose either Sticky Note or Highlight Text

In-text edits
Select the appropriate symbol and then click and drag over the text to be modified.
- Replace $\boldsymbol{\text{R}}$ : denotes where the text should be replaced with an alternative option
- Strikethrough $\boldsymbol{\text{T}}$ : crosses out the text
- Underline $\boldsymbol{\text{U}}$ : underlines the text
- Add note to text $\boldsymbol{\text{A}}$ : links selected text with a pop-up note

Sticky notes
To make a note: choose the Sticky Note option and then click on a desired location
- Changing the name: double-click and choose Options → Sticky Note Properties → General → insert desired name
- To move: click anywhere (apart from the text field) and drag
- To resize: click on the right or left hand order and drag
- To close: click the box on the upper right corner; this does NOT delete your note
- To delete: click and press the Delete keyboard button or right click and select delete from the drop-down menu

Highlighting
This allows you can highlight parts of the text.
- To highlight: select Highlight and then click and drag over the text to be highlighted. When finished, click on Highlight again to turn off the option.
- To change the colour: double-click on the highlighted text and choose Options → Properties → Appearance → Color

Saving your changes:
Click on File → Save before closing the document.

For more detailed instructions on using Adobe Acrobat, please refer to http://www.adobe.com/support/acrobat/gettingstarted/
Molecular profiling of a case of advanced pancreatic cancer identifies an active and tolerable combination of targeted therapy with backbone chemotherapy

Benny Johnson¹, Ari Vanderwalde¹, Nader Javadi², Rebecca Feldman³, Sandeep Bobby Reddy³

¹The University of Tennessee Health Science Center and West Cancer Center, Memphis, TN 38120, USA; ²Hope Health Center, Reseda, CA, USA; ³Caris Life Sciences, Irving, TX, USA

Correspondence to: Benny Johnson, DO. Division of Hematology/Oncology, The University of Tennessee Health Science Center, West Cancer Center, 100 Humphreys Blvd, Memphis, TN 38120, USA. Email: bejohnson@westclinic.com.

Abstract: Typical survival with common 1st-line regimens for pancreatic cancer range from 6-11 months. We report a case of a patient with stage IVB pancreatic adenocarcinoma treated with gemcitabine and erlotinib who stopped therapy after 3 months without achieving a response due to intolerance. To decide upon additional treatment options, molecular analysis was performed on liver metastasis which revealed KRAS, FBXW7, APC, and ATM mutations, with thymidylate synthase (TS) negativity and PD-1 positivity. Based on this profile of TS negativity and ATM mutation, a combination strategy was devised consisting of capecitabine, oxaliplatin, bevacizumab and vorinostat. The patient had a near complete response to therapy with this regimen. In refractory metastatic pancreatic cancer, responses of this magnitude are rarely seen. To our knowledge, this represents the first demonstrated activity of this combination in the metastatic setting which could prompt further investigation of its use in large scale clinical trials.

Keywords: Metastatic pancreatic cancer; molecular profiling; targeted therapy

Case presentation

A 62-year-old Iranian male without significant past medical history presented with weight loss and painless jaundice in November 2013. A CT scan of the chest, abdomen and pelvis identified multiple liver masses and a presumptive pancreatic mass. He underwent endoscopic retrograde cholangiopancreatography (ERCP) and had a metallic stent placed with marked improvement of his symptoms. CT-guided biopsy of the liver mass was performed and pathology was consistent with moderately differentiated adenocarcinoma, morphologically consistent with metastatic spread from a pancreatic primary (Stage IVB).

The patient was started on palliative chemotherapy with gemcitabine and erlotinib by his primary oncologist in February 2014 based on Moore et al. (1). In March 2014, the patient developed severe nausea and vomiting due to cholecystitis and underwent cholecystectomy. Repeat CT scan in April 2014 showed stable disease, however due to persistent severe side effects, gemcitabine and erlotinib were discontinued in mid-May 2014. The patient continued to report progressive fatigue, weight loss and anorexia associated with right upper quadrant and epigastric discomfort. PET/CT 1 month after stopping therapy revealed greater than 20 hypermetabolic liver masses in both lobes, the largest measuring within 4-5 cm, a 5.7 cm × 5 cm pancreatic head mass, and retroperitoneal lymph nodes (Figure 1). Multi-modal molecular profiling of the tumor specimen collected on January 9, 2014 was performed at this time, (Caris Molecular Intelligence®, Irving, TX) and revealed the following alterations detailed in Table 1.

Interpretation of these findings suggested a likely benefit of capecitabine due to the thymidylate synthase (TS) negativity and or possible response to histone deacetylase inhibitors (HDACi) such as vorinostat based on the ATM
mutation. Based on this molecular profile, the treating physician instituted therapy with capecitabine, oxaliplatin and bevacizumab with the addition of vorinostat. After six cycles of therapy, laboratory evaluation revealed improvement in liver function, and marked decline in CEA from 115 to 8 mcg/L and CA 19-9 from 80,000 to 1,525 U/mL. Repeat PET/CT imaging in November 2014 revealed a greater than 50% decrease in the size of the pancreatic head lesion to 2.5 cm x 2.5 cm, with a corresponding decrease in PET avidity. Additionally, there was complete resolution of the previously noted hepatic metastases as well as the retroperitoneal lymphadenopathy (Figure 2). This represents at least an 80-90% response to current therapy by PET/CT.

**Table 1** Caris molecular profiling of liver biopsy

<table>
<thead>
<tr>
<th>Test</th>
<th>Modality (IHC/ISH/NGS)</th>
<th>Alteration</th>
<th>Interpretation</th>
</tr>
</thead>
<tbody>
<tr>
<td>TS</td>
<td>IHC</td>
<td>1+ (intensity) &amp; 5% (cell staining)</td>
<td>Negative</td>
</tr>
<tr>
<td>RRM1</td>
<td>IHC</td>
<td>2+ (intensity) &amp; 15% (cell staining)</td>
<td>Negative</td>
</tr>
<tr>
<td>ATM</td>
<td>NGS</td>
<td>M1830V</td>
<td>Variant of unknown significance</td>
</tr>
<tr>
<td>KRAS</td>
<td>NGS</td>
<td>G12D</td>
<td>Pathogenic mutation</td>
</tr>
<tr>
<td>APC</td>
<td>NGS</td>
<td>T1556fs</td>
<td>Pathogenic mutation</td>
</tr>
<tr>
<td>FBXW7</td>
<td>NGS</td>
<td>R465H</td>
<td>Pathogenic mutation</td>
</tr>
<tr>
<td>PD-1*</td>
<td>IHC</td>
<td>1/HPF</td>
<td>Positive</td>
</tr>
</tbody>
</table>

*, PD-1 staining is read from the tumor infiltrating lymphocytes (TIL) per high-powered field (HPF). TS, thymidylate synthase; NGS, next generation sequencing.

**Discussion**

Pancreatic adenocarcinoma is the 4th leading cause of cancer mortality in the United States. The disease is particularly deadly, with approximately 82% of those affected ultimately dying of their disease (2). Patients with localized disease who are eligible for surgical resection still have a median survival of only 22.8 months due to high recurrence rates (3). Lack of effective screening tools results in the majority of affected individuals presenting with advanced metastatic disease for which palliative chemotherapy is standard. Standard first line regimens include gemcitabine alone, with erlotinib, or with nab-paclitaxel; or folinic acid, 5-fluorouracil, irinotecan, and oxaliplatin (FOLFIRINOX).
Currently, median survival with single agent gemcitabine is 5-7 months compared to 8.5-11 months with newer chemotherapeutic regimens such as FOLFIRINOX and gem/nab-paclitaxel (4,5). There are no standard therapies after failure or intolerance of 1st line therapy. Although FOLFIRINOX and gem/nab-paclitaxel have produced an improved overall survival, they are best applied to a patient population with good performance status due to their association with increased toxicities. To date, targeted therapy in pancreatic cancer has been limited to erlotinib, a small-molecule tyrosine-kinase inhibitor of EGFR used in combination with gemcitabine. However, this combination therapy has only resulted in a very subtle median overall survival advantage measured in days (1). Therefore, well-designed clinical trials to identify impactful targeted therapy in pancreatic adenocarcinoma are desperately needed.

Over recent years therapy in oncology has moved away from traditional chemotherapy due to the identification of “drug-able” targets in multiple solid malignancies. For instance, in advanced melanoma 40% of patients have been found to have a BRAF V600E mutation that allows for the use of BRAF inhibitors such as vemurafenib and dabrafenib as well as MEK inhibitors such as trametinib, which both alone and in combination have demonstrated improved survival in tumors with these mutations (6,7). This same success was reached in advanced non-small cell lung cancer (NSCLC), as identification of patients with an EML4-ALK translocation allows for the use of the small molecule tyrosine kinase inhibitor crizotinib which nearly doubles median overall survival when compared to standard doublet chemotherapy (8). Likewise, activating EGFR mutations have shown dramatic responses to anti-EGFR tyrosine kinase inhibitors such as erlotinib and afatinib (9).

To that end, potential actionable targets in pancreatic cancer are actively being investigated. Recently a review of the Catalogue of Somatic Mutations in Cancer (COSMIC) database (accessed December 1, 2014) reveals that most pancreatic cancers contain somatic mutations, the most common of which include KRAS, TP53, CDKN2A, SMAD4, and ARID1A. Other mutations involved include ATM, FBXW7, and APC which were present in our patient as well as MLL3, PIK3CA, BRAF and STK11/LKB1. Early use of next generation sequencing (NGS) in 24 pancreatic cancers revealed an average of 63 mutations and 12 core signaling pathways of which at least one, and usually many, is genetically altered in the majority of tumors analyzed (11). Of note, key pathways identified include apoptosis, DNA damage control, regulation of G1/S phase, hedgehog, homophilic cell adhesion, integrin signaling, c-Jun N-terminal, Wnt/Notch, KRAS, regulation of invasion, small GTPase-dependent signaling, and TGF-β.

KRAS or V-Ki-ras2 Kirsten rat sarcoma viral oncogene...
homolog encodes a signaling intermediate involved in many signaling cascades including the EGFR pathway. Greater than seventy percent of pancreatic cancer samples in the COSMIC cohort contain a KRAS mutation (12). KRAS regulates cell survival and differentiation by activating multiple signaling pathways. Mutations in KRAS interfere with the hydrolysis of GTP resulting in a constitutively active state (13). These mutations are common in pancreatic ductal cancer cells and play a significant role in the early development of malignancy (14).

KRAS somatic mutations have been found in pancreatic (57%), colon (35%), lung (16%), biliary tract (28%), and endometrial (15%) cancers. Mutations at activating hotspots are associated with resistance to EGFR tyrosine kinase inhibitors (erlotinib, gefitinib) in NSCLC and monoclonal antibodies (cetuximab, panitumumab) in CRC patients. Current clinical trials are focusing on key downstream targets of KRAS, such as MEK, for which multiple inhibitors are in development. To date, MEK inhibition in pancreatic cancer has not resulted in major gains. A randomized phase II trial in pancreatic cancer with the MEK inhibitor trametinib in combination with gemcitabine versus gemcitabine alone did not result in a statistically significant prolongation of overall survival, despite achieving a 22% response rate in the combination arm (15). Combining MEK inhibitors with other agents in pancreatic cancer remains a focus of clinical investigation.

Of note, our patient was unable to tolerate erlotinib therapy and did not achieve a measurable response.

APC or adenomatous polyposis coli are a key tumor suppressor gene that encodes for a large multi-domain protein (16). This protein exerts its tumor suppressor function in the Wnt/β-catenin cascade mainly by controlling the degradation of β-catenin, the central activator of transcription in the Wnt signaling pathway. The Wnt signaling pathway mediates important cellular functions including intercellular adhesion, stabilization of the cytoskeleton, and cell cycle regulation and apoptosis, and it is important in embryonic development and oncogenesis.

Mutation in APC results in a truncated protein product with abnormal function, lacking the domains involved in β-catenin degradation. Somatic mutation in the APC gene can be detected in the majority of colorectal tumors (80%) and it is an early event in colorectal tumorigenesis. APC wild type patients have shown better disease control rate in the metastatic setting when treated with oxaliplatin, while when treated with fluoropyrimidine regimens, APC wild type patients experience more hematological toxicities.

APC mutation has also been identified in oral squamous cell carcinoma, gastric cancer as well as hepatoblastoma and may contribute to cancer formation. Various clinical trials (on www.clinicaltrials.gov) investigating agents which target this gene and/or its downstream or upstream effectors maybe available for APC mutated patients. Our patient was in fact APC mutated suggesting a diminished response to oxaliplatin alone, however a more hematologic tolerability to the addition of 5-FU based therapies.

The identification of biomarkers to predict chemotherapeutic sensitivity has been extensively studied. Of note, the use of TS represents a classic example of this pursuit. TS is a crucial enzyme that is involved in one of the nucleotide biosynthesis pathways and converts deoxuryridine monophosphate (dUMP) to deoxothymidine monophosphate (dTMP) through methylation via 5,10-methylene tetrahydrofolate [CH(2)THF] (17). As we know, 5-FU, an antimetabolite, is one of the most frequently used anti-neoplastic agents in cancer therapy today. Once 5-FU enters the cell it is metabolized into 5-fluorodeoxyuridine monophosphate (FdUMP). FdUMP produces a stable enzyme complex with TS and CH(2)THF resulting in significant inhibition of the thymine biosynthesis pathway, depleting the nucleotide dTTP (18,19), thereby abrogating DNA replication. Of note, TS expression markedly varies in human malignancies (20,21). Therefore, the therapeutic response to 5-FU may have a wide range of clinical variability based on the expression levels of TS. To date the literature regarding whether TS expression accurately predicts for 5-FU or other fluoropyrimidines response remains inconsistent (22). However, in our case, TS expression was negative and our patient had a significant response to a capecitabine-containing backbone therapy.

ATM or ataxia telangiectasia mutated is activated by DNA double-strand breaks and DNA replication stress. It encodes a protein kinase that acts as a tumor suppressor and regulates various biomarkers involved in DNA repair, which include p53, BRCA1, CHK2, RAD17, RAD9, and NBS1. Although ATM is associated with hematologic malignancies, somatic mutations have been found in colon (18%), head and neck (14%), and prostate (12%) cancers. Inactivating ATM mutations make patients potentially more susceptible to PARP inhibitors. Of note, the ATM gene controls aspects of both DNA repair and multiple cell cycle checkpoints (23). Therefore, in cells with mutated ATM, both DNA repair and cell cycle control pathways are faulty. FBXW7 is a gene involved in the regulation of G1/S phase transition regulating a pathway that is commonly mutated.
in pancreatic cancer. Wild type FBXW7 is involved in ubiquitin-mediated degradation of oncoproteins. Low levels have been found to be associated with poorer survival and increased resistance to chemotherapy, specifically taxane-based. In NSCLC cell lines, when FBXW7 is silenced, the sensitivity to taxane therapy returns with treatment using an HDACi (24). Histone acetylation/deacetylation modifies the state of chromatin domains and thereby affects gene transcription, a process regulated by HDACi. In addition to their role in histone modification, HDACi have also been shown to impact activation of DNA repair. In cells with mutated ATM as in our patient, it is reasonable to assume that the application of HDACi could further compromise the DNA repair pathway, resulting in the cell initiating an apoptotic response (25).

HDACi and fluoropyrimidines are synergistic as well as known radiation sensitizers (26). An ongoing phase I clinical trial evaluating the use of combination therapy with capecitabine, HDACi vorinostat, and external-beam radiation therapy (RT) in patients with non-metastatic pancreatic cancer has reported preliminary results supporting activity of the combination (27). Diffusion weighted-MRIs were obtained pre treatment and 1 week after treatment to evaluate tumor cellularity. Peripheral blood mononuclear cells (PBMCs) were also collected pre treatment, during treatment and after completion of treatment to assess HDAC activity. The 18 patients were enrolled to the study resectable (n=1); borderline resectable (n=9); and unresectable (n=8). Common adverse events were lymphopenia, GI toxicity, and fatigue. HDACi and apparent diffusion coefficient decrease on DWI-MRI was identified. This regimen was found to be a tolerable with very minimal toxicity. The trial is ongoing with accrual to the final cohort of vorinostat at 400 mg (26). Though results have not been reported, the fact that the final planned dose cohort was reached may suggest that the combination of fluoropyrimidines and HDACi thus far a tolerable regimen in non-metastatic pancreatic cancer.

Further investigation is warranted to implore the use of HDACi with backbone chemotherapy in metastatic pancreatic cancer dependent upon a patient’s specific mutational profile, considering its acceptable tolerability and impressive response to therapy. Recent clinical trials that have been concluded in pancreatic cancer include a combination of proteasome inhibitors and HDACi, HDACi plus RT, and HDACi plus RT and infusional 5-FU. A trial of gemcitabine, nab-paclitaxel, sorafenib and vorinostat in previously untreated stage IA, IB, IIA, IIB and III pancreatic cancer patients is now actively recruiting (www.clinicaltrials.gov, NCT02349867).

VEGF and its receptors are frequently overexpressed in pancreatic cancer and other adenocarcinomas. CALGB 80303 was a randomized trial comparing gemcitabine + bevacizumab vs. gemcitabine alone with a primary end point of overall survival. The trial was not statistically significant but PFS was marginally better (P=0.07) (28). A second randomized trial evaluated gemcitabine + erlotinib + bevacizumab vs. gemcitabine + erlotinib (29). The primary endpoint was OS which was not statistically significant however the secondary end point of PFS was significantly better (P=0.0002; HR =0.73). Although bevacizumab is not standard of care these findings suggest some value in its use as a therapeutic option for metastatic pancreatic cancer.

Our case highlights the possibility of a level of clinically relevant synergism between HDACi and anti-angiogenesis warranting further investigation of this combination therapy based on NGS.

Of note, our case also reported PD-1 positivity in the patient's mutational profile. While PD-1 is not a known biomarker for the activity of any molecules, it may serve as an indicator that the tumor specimen has some degree of immunogenicity, which could speak to a potential role for immunotherapy in this disease.

Conclusions

As of 2015, the overall prognosis of pancreatic cancer remains grave with a five year overall survival less than 5% (30). For metastatic pancreatic cancer, systemic chemotherapy with FOLFIRINOX or gemcitabine and nab-paclitaxel offer patients the best median over survival. In other solid malignancies such as melanoma and NSCLC, the advent of targeted therapy has resulted in significant progress in terms of overall outcomes for patients whose tumors harbor specific mutations or alterations.

Pancreatic cancer has multiple potentially “drug-able” targets as defined in both the COSMIC database as well as NGS of pancreatic tumor tissue. Interestingly, to date <10% of clinical trials in pancreatic cancer involve the identification and use of a biomarker of significance. Our case highlights that the identification of multiple mutational targets allows for a personally tailored focus in regards to therapy. For the first time we report that the addition of an HDACi and an anti-VEGF agent to acceptable backbone chemotherapy of CapeOx (31) for metastatic pancreatic cancer results in significant overall response rate. Further
investigation utilizing this targeted approach with backbone chemotherapy in large scale clinical trials is warranted. Considering the numbers of somatic mutations generally identified in most pancreatic cancers, focusing on a single mutational target alone is unlikely to result in significant clinical impact.

Acknowledgements

None.

Footnote

Conflict of Interest: The authors have no conflicts of interest to declare.

References


Cite this article as: Johnson B, Vanderwalde A, Javadi N, Feldman R, Reddy SB. Molecular profiling of a case of advanced pancreatic cancer identifies an active and tolerable combination of targeted therapy with backbone chemotherapy. J Gastrointest Oncol 2015. doi: 10.3978/j.issn.2078-6891.2015.091